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Customer Service 
 

If a problem arises which cannot be resolved with the help of this documentation, please 

contact customer service using any of the following numbers or addresses: 

 

Gesellschaft für Bild- und Signalverarbeitung (GBS) mbH  

Werner-von-Siemens-Straße 10  

D-98693 Ilmenau  

 

Telefone: +49 (0) 3677-6897683 

Fax: +49 (0) 3677-6897682 

Web: www.gbs-ilmenau.de 

Email: support@gbs-ilmenau.de 

 

 

Maintenance and Warranty 
 

Any type of software maintenance, including applying of software updates and bug fixes, will 

be performed by the manufacturer using remote maintenance software where possible. 

 

The length of the warranty for the purchased smartVIS3D software is governed by the 

concluded contract with Gesellschaft für Bild- und Signalverarbeitung mbH. 

 

 

 

 

 

 

 

 

 

http://www.gbs-ilmenau.de/
mailto:support@gbs-ilmenau.de
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1. Measurement principle 

1.1. Principle Description 

The basic white-light interferometry setup utilizes an optical interferometer, e.g. Michelson 

interferometer as shown in Figure 1. The principle behind the measurement process is based 

upon the fact that spatially and temporally coherent light waves can be superimposed. To 

exploit this behavior, the optical interferometer is equipped with a broadband white-light 

source and the following steps are applied during the measurement procedure. The light 

source emits a beam into the beam splitter, where it is splitted into two separated beams. 

One of these created beams (reference beam) follows a constant optical path to the 

reference mirror and the other one (measurement beam) is passed to the object to be 

measured. Both beams are reflected from corresponding surfaces and directed through the 

beam splitter to a CCD-camera (cf. Figure 1). On the way back the reflected beams are 

superimposed. If the optical path difference of both beams is within coherence length of used 

light then interferences occur. 

 

 
 

FIGURE 1: MICHELSON’S INTERFEROMETER AND THE WORKING PRINCIPLE OF THE WHITE-

LIGHT INTERFEROMETRY 

 

During the measurement procedure the objective is moved within a defined range (the upper 

and lower limits of which can be set in the control software) perpendicularly to the 

specimen’s surface using a specific step pattern, the default step width in the smartVIS3D 

measurement software from GBS mbH is λ/8. Due to this translation of the objective the path 
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length of the measurement beam is altered, while the path length of the reference beam 

remains the same. Therefore a change of interference intensities recorded by the camera 

sensor can be observed. When the optical path difference is zero for a particular x,y-position 

on object's surface, then the interference intensity for this position is maximal. The z-position 

of the translation arm at which the maximum interference was measured can be used to 

compute the height for that specific x,y-location. In Figure 2 during a scan procedure with N 

measurement positions in z-direction obtained interference signals (interferogram) for 

adjacent pixels are shown.  

 

 

FIGURE 2: DURING THE MEASUREMENT PROCEDURE OBTAINED INTERFEROGRAMS FOR 

ADJACENT PIXELS. THE RED CIRCLES REPRESENT THE SCAN POSITION (IN Z-

DIRECTION) AT WHICH THE MAXIMUM INTERFERENCE INTENSITY FOR A 

PARTICULAR PIXEL WAS MEASURED 

In Figure 2 it can be also seen, that the signal segments of obtained interferograms at which 

significant interference intensities can be observed are much smaller than the scan range 

(N * w) of the measurement procedure. These segments are called correlograms and they 

correspond to the coherence length of the used white-light source. 

After the measurement has been completed smartVIS3D transmits the measurement results 

to the MountainsMap® analysis software. 
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1.2. Vertical Scanning-Interferometry (VSI) and Phase-

Shifting Interferometry (PSI) Modes Description 

In the following table the comparison of the supported measurement modes VSI and PSI in 

smartVIS3D software is shown. 

 

Mode VSI PSI 

Light-source 

and filter 

settings 

 white-light with short coherence 

length 

 no filter 

 white-light with long coherence 

length 

 bandpass filter 

Properties  non-tactile and non-destructive 

 fast (seconds to few minutes) 

 height resolution of ≤10 nm 

 operates on rough surfaces with 

an Ra < 400 µm 

 non-tactile and non-destructive 

 very fast (few seconds) 

 height resolution of ≤1 nm 

 operates on smooth, polished 

surfaces with an Ra < 200 nm 

Description Because white light – due to its 

broad spectrum – exhibits a very 

short coherence length, interference 

fringes are observed only in a small 

band around the focus position. The 

interference fringe contrast maxim-

um is achieved when passing 

through the focal distance. When the 

objective scan position adjuster 

moves the objective through the 

previously set movement range, 

individual images are acquired at 

specific step distances (the default is 

λ/8). The total number of individual 

images increases as the interval size 

increases. 

 

Example: If λ/8 = 79 nm and the 

interval size is set to 200 µm, a total 

Generates phase data from the 

intensity signals which is then used 

to calculate the surface profile. The 

objective is held at its focal 

distance. The interference maxim-

um (of the correlogram) completely 

fills the image. The interference 

objective is moved and 5 individual 

images are taken. Between each of 

these 5 scan positions a phase-

shift of λ/8 is used. If the height 

difference between adjacent mea-

surement points on the clean 

surface is larger than λ/4, then the 

height deviation can be a multiple 

of λ/2 and the wavefront cannot be 

reliably reconstructed. Because of 

this ambiguity, normal phase-

shifting interferometry (PSI) can 
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number of approx. 2500 individual 

images (the image stack) will be 

taken. All of these ~2500 images 

must be processed by the 

measurement software. 

 

only be used for scans of very 

smooth continuous surfaces. 
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2. Software Description 

The user interface of the smartVIS3D measurement software features a clearly arranged and 

easy-to-use layout. The measurement software in combination with the MountainsMap® 

analysis software is delivered pre-installed and ready to use. 

 

2.1. Main Window 

 

 

 

 

 

FIGURE 3: SMARTVIS3D MAIN WINDOW 
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No. Description 

1 Live image captured by the camera. The live image corresponds to the measurement 

field. The magnification factor, e.g. 20x, of the objective is shown on the left side below 

the image. The length scale, e.g. 100 µm, is shown on the right side below the image. 

 

2 Menu items (File, Options, View, Help). 

 

3 Scroll-up button for z-positioning of the objective using the piezo objective adjuster. 

The positioning button is controllable by mouse. 

 

4 “Go” button to move the z-position scrollbar (11) to the z-position defined in field (6) or 

to a position with relative distance defined in field (7) from the current position shown 

in field (5). 

 

5 Display field for the current z-position of the objective. 

 

6 Input field for setting the desired z-position to which the scrollbar (11) will be moved 

when the “Go” button or the Enter key on the keyboard is pressed. Additionally after 

pressing the “Go” button or the Enter key the current z-position value in field (5) will be 

updated to the value provided here. 

 

7 Input field for setting the desired z-position relatively to the current z-position. After 

pressing the “Go” button or the Enter key on the keyboard the z-position scrollbar (11) 

will be moved from the current position by the value provided here. Additionally after 

pressing the “Go” button or the Enter key the current z-position value in field (5) will be 

updated to the new position value. 

 

8 The display field shows the maximum z-position (background color of the field is black) 

or user-defined upper limit on z-position (background color of the field is blue). 

 

9 By the user defined upper limit on z-position shown in display field (8) can be resetted 

to the maximum z-position value by pressing this button. 
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10 The upper bound z-position shown in display field (8) can be set to the current position 

of the scrollbar (11) using this button. 

 

11 Z-Position scrollbar, which can be used to manually set the z-position of the piezo 

adjuster and to select the z-position for the maximum and minimum scan position. 

Each time the position of the scrollbar is changed the value in display field (5) is 

updated to the new position and in the live view (1) interference patterns resulting from 

the new z-position of the piezo adjuster can be seen. The scrollbar is controllable by 

the mouse. 

 

12 The display field shows the minimum z-position (background color of the field is black) 

or user-defined lower limit on z-position (background color of the field is blue). 

 

13 By the user defined lower limit on z-position shown in display field (12) can be resetted 

to the minimum z-position value by pressing this button. 

 

14 The lower bound z-position shown in display field (12) can be set to the current 

position of the scrollbar (11) using this button. 

 

15 Progress bar for the measurement process. 

 

16 The “Start Measurement” button starts the measurement. It is enabled after the user 

has set the upper and lower limit for the scan procedure. 

 

17 Scroll-down button for z-positioning of the objective using the piezo objective adjuster. 

The positioning button is controllable by mouse. 

 

18 The positioning/measurement range bar shows the currently specified position (blue 

end marker, top) and the user-defined scan interval (black) with respect to the entire 

available scan range. 

 

19 Measurement scale display (length scale). 
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20 

 

Measurement options (section 2.3.1): 

 Processing unit (CPU / GPU) 

 Measurement Method (VSI / PSI) 

 Scan step width in nm 

 Measurement data quality threshold 

21 Current status. 

 

 

2.2. File Menu 

 

 

FIGURE 4: SMARTVIS3D FILE MENU 

No. Description 

1 Saves the currently displayed camera image available in the data processing format 

(monochrome, 16-bit) as an image file: (*.tif), (*.bmp), (*.jpg) or (*.hdr), like shown in 

the following figure: 

 

 

 

2 Saves the current color-coded view of the camera image (color, 8-bit, with pseudo-

colors for under- or overexposure as an image file: (*.tif), (*.bmp), (*.jpg) or (*.hdr), 

like shown in the following figure: 
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3 Saves the current color-coded view of the camera image with additional information 

(displayed in red) as an image file: (*.tif), (*.bmp), (*.jpg) or (*.hdr), like shown in the 

following figure: 

 

 

 

4 Opens a file dialog which can be used to export the measurement results into the 

following formats: 

 MountainsMap® binary file format: *.sur 

 SPIP binary file format: *.bcrf 

 SPIP ASCII file format: *.asc 

 Pointwork ASCII file format: *.a3d 

 

5 Opens a file dialog to choose a MountainsMap® document template: *.mnt. The 

name of the selected template will then appear in the title area of the main window 

(smartVIS3D measurement - chosen report template: “selected name”.mnt), like 

shown in the following figure: 

 

 

 

6 Starts the calibration procedure. 

 

7 Exits the smartVIS3D measurement software. 
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2.3. Options Menu 

 

 

 

FIGURE 5: SMARTVIS3D OPTIONS MENU 

No. Description 

1 Opens the “Measuring options” dialog, see section 2.3.1. 

 

2 Opens the “Measuring procedures” dialog, see section 2.3.2. 

 

3 Opens the “Positioning device motion control” dialog, see section 2.3.3. 

 

Note: “Positioning control” menu entry is available only for devices with 

motorized positioning axes. 

4 Opens the “Light control” dialog, see section 2.3.4. 

 

Note: “Light control” menu entry is available only for devices with an integrated 

light control hardware module. 

5 Opens the “Stitching-Measurement” dialog for the auto-stitching process, see 

section 2.3.5.1. 

For general information on the stitching process refer to section 2.3.5. 

 

Note: “Stitching” menu entry is available only for devices with motorized 

positioning axes. 
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6 Shows reference lines for the manual stitching process, see section 2.3.5.2. 

For general information on the stitching process refer to section 2.3.5. 

 

7 “Save image stack” is an option field which can be checked and unchecked. 

On startup of the smartVIS3D software this field is unchecked. By checking 

this option field, using the left mouse button, the control logic of the software 

will be notified that all captured interference images (image stack) must be 

stored on the hard drive. This image stack can be used by the manufacturer to 

perform debugging and analysis steps in case measurement or analysis errors 

are encountered during a scan procedure.  

 

 

 

2.3.1. Measuring Options Dialog 

 

 

 

 

 

FIGURE 6: SMARTVIS3D MEASURING OPTIONS DIALOG 
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No. Description 

1 Currently selected objective. Make sure to select the objective corresponding to the 

mounted objective, as the measurement accuracy depends on it. 

 

2 Selection of the processing unit: 

 “GPU” (Graphics Processing Unit): Is faster than CPU, suitable for VSI mode. 

 “CPU” (Central Processing Unit): Is slower than GPU, suitable for VSI and PSI 

mode. 

 

3 Selection of the z-position step width: 

 Auto: Default value 1x. Using higher increment value larger step width will be 

used, resulting in faster measurement speed, at the expense of lower accuracy. 

 Adjustable: Here a specific step width value (in nm) can be entered. 

Note: Usually no changes to these settings are required.   

 

4 Trigger source selection: 

 “Built-in”: Default mode for smartWLI devices. Frame capture trigger will be sent 

by an internal hardware module within the smartWLI device. 

 “External”: Is selectable only for smartWLI-OEM devices in stroboscopic mode. 

Frame capture trigger will be sent by an external hardware module. 

 

5 Setting for the quality threshold with a value in the interval [0…1]. The threshold can 

be set using the slider, the spin-control or can be entered directly in the input field. 

The default value is 0.030. During processing a quality value is calculated for each 

measured point (pixel). This value indicates how trustworthy the measured point is. A 

setting of 0.000 indicates that all measured points will be exported to the analysis 

software. If the value is set to a value larger than 0.000, only measured values with a 

quality better than the threshold will be exported. 

 

Important: An incorrectly chosen threshold can cause gaps in the measured data (so-

called NM points in the MountainsMap® analysis software). This parameter makes it 

possible to separate unreliably detected measured data from reliable data.  
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Note: Gaps in the measured data are acceptable, as they can be interpolated later 

with the help of the analysis software. 

 

6 Measurement method selection: 

 “VSI” (Vertical Scanning-Interferometry): VSI mode is the default measurement 

mode of the smartVIS3D software. Here a white-light source with a short 

coherence length is used. In contrast to the “PSI” mode the “VSI” mode can be 

used for both rough and smooth surfaces. However for smooth surfaces it yields 

less precise measurement results than the “PSI” mode. 

 “PSI” (Phase-Shifting Interferometry): The “PSI” mode is available as an optional 

software module. Together with a white-light source of a long coherence length a 

bandpass filter is used. This method yields very accurate measurement results. 

However in contrast to the “VSI” mode it is suitable only for smooth surfaces 

(Ra < 200 nm) without large height jumps. Suitable objects are e.g. wafers, glass 

and mirrors. 

 

7 This option is enabled only in “VSI” mode. For specimens with a smooth surface 

(Ra < 200 nm) a significantly higher accuracy can be achieved when the option 

“Smooth” is selected. On the other side, for objects with a rough surface using the 

option “Smooth” should be avoided. In following figures the achieved measurement 

results using the option “Rough” (figure on the left) and the option “Smooth” (figure on 

the left) for the same object are shown. 

 

 

8 Accept the new settings. 

 

9 Exit the “Measuring Options” dialog without accepting the new settings. 
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2.3.2. Measuring Procedures Dialog 

The measuring procedures dialog can be used to save and reload measuring settings. This 

applies to the settings in “Measuring options” dialog, see section 2.3.1, to the light settings, 

the name of the MountainsMap® document template, which is set using the “Choose report 

template” menu field in the “File” dropdown menu, see section 0, and the upper and lower 

scan range limits, which are set in the main window, see section 2.1. 

 

 

 

 

 

FIGURE 7: SMARTVIS3D MEASURING PROCEDURES DIALOG 

No. Description 

1 Name of the measuring procedure. To create a new measuring procedure a new 

procedure name must be entered here before button (8) is clicked.   

 

2 To rename a measuring procedure it must be selected in (1) then this button must be 

pressed and afterwards a new name entered in (1). A message box will appear 

asking you if you really want to change the name of the selected procedure. By 

pressing “Yes” the selected procedure will be renamed. 
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3 To delete a measuring procedure, select it first in (1) and press then on this button. A 

message box will appear asking you if you really want to delete the selected 

procedure. By clicking the “Yes” button the selected procedure will be permanently 

removed from the list. 

 

4 Press this button to delete all measuring procedures available. After pressing the 

“Delete all” button a message box will appear asking you if you really want to delete 

all available procedures. By pressing the “Yes” button all stored procedures, except 

the “PRESET” procedure, will be removed permanently from the list.  

 

5 Index of the selected procedure. 

 

6 If this option is checked, then all changes will be stored automatically. 

 

7 Overwrite the settings of the selected procedure by the currently selected settings in 

“Measuring options” and in “Light control” dialogs. Also the currently selected 

MountainsMap® document template, which is set using the “Choose report template” 

menu field in the “File” dropdown menu,  and the upper and lower scan range limits 

defined in the main window will overwrite the corresponding settings in the selected 

procedure. After pressing the “Set current settings” button a message box will appear 

asking you if you really want to overwrite the settings of the selected procedure. By 

pressing the “Yes” button selected procedure settings will be overwritten. 

 

8 Add a new measuring procedure with current settings. 

 

Note: To add a new measurement procedure to the list a new name, not yet available 

in the procedure list, must be entered in field (1) before pushing this button. 

 

9 Reset all current settings by the settings of in (1) selected measuring procedure and 

exit the dialog. 

 

10 Exit the dialog without any changes to current settings. 
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2.3.3. Position Control Dialog (available only for devices with 

motorized positioning axes) 

 

Note: This dialog can be used alternatively to a joystick to move the motorized axes of the 

measurement device.  

 

 

FIGURE 8: SMARTVIS3D POSITION CONTROL DIALOG 

Control group name Controls description 

Control name Description 

Positioning Measuring (Predefined) This button is enabled in case a 

predefined measurement position is 

available. By clicking on this button the 

predefined coordinates will be entered 

automatically to the coordinate fields. To 

move the motorized stage to these 

coordinates push the “Absolute” 

(Movement) button. 
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Loading (Predefined) This button is enabled in case a 

predefined sample loading position is 

available. By clicking on this button the 

predefined coordinates will be entered 

automatically to the coordinate fields. To 

move the motorized stage to these 

coordinates push the “Absolute” 

(Movement) button. 

 

Home (Predefined) This button is enabled in case an initial 

position is available. By clicking on this 

button the predefined coordinates will 

be entered automatically to the 

coordinate fields. To move the 

motorized stage to these coordinates 

push the “Absolute” (Movement) button. 

 

X, Y, Z (Active) Using these check boxes control of the 

respective axis through the “Positioning 

Control” dialog can be enabled. A 

specific check box is enabled only if the 

positioning device features the 

corresponding motorized axis. 

 

X, Y, Z (Coordinates) If an X, Y or Z axis is available and 

enabled then in the corresponding 

coordinate field desired coordinates for 

this axis in mm can be entered. 

 

Absolute (Movement) This Button is enabled when at least 

one of the X, Y or Z axis is enabled. By 

clicking on this button the motorized 

axes assume new positions 

corresponding to the provided 

coordinate values. 
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Relative (Movement) This Button is enabled when at least 

one of the X, Y or Z axis is enabled. By 

clicking on this button the motorized 

axes assumes new positions using the 

provided coordinate values as relative 

distance values to the current position. 

 

Reference Zero point calibration Starts a calibration movement 

procedure to the point of origin position 

of the motorized stage coordinate 

system (upper left corner) 

Range measurement Starts a calibration movement 

procedure to the farthest position (lower 

right corner) in relation to the point of 

origin position of the motorized stage 

coordinate system  

Release Emergency Stop After the emergency stop button on the 

measurement device is pressed it isn’t 

enough to release the mechanical 

emergency stop button to be able to 

proceed with measurements but it is 

also necessary to release the software 

emergency lock by pressing this button 

Joystick Direction Buttons By clicking on any of these buttons the 

motorized axes move the positioning 

table in the corresponding direction. 

 

Speed X, Y, Z Here during any movement used speed 

for each axis can be adjusted in mm/s 

using the slider controls, the spin 

controls or by entering the desired 

speed value directly into the input fields. 

 

Constant moving / Steps 

 

Movement mode selection: 

 In “Constant moving” mode as long 

as the user presses a joystick 
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direction button the motorized axes 

will execute a continuous motion 

until the button is released by the 

user 

 In “Steps” mode each time the user 

presses a joystick direction button 

the motorized axes will execute a 

corresponding movement in the 

desired direction for a predefined 

time period 

State - Here the current status of the motorized 

positioning table is shown. 

Current position X, Y, Z Here the coordinates of the current 

position are shown. 

 

- Stop  Emergency stop button. 

Press on this button to 

cancel immediately all 

movements of the moto-

rized positioning table. 

 
 

- Close Exits the “Positioning Control” dialog. 
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2.3.4. Light Control Dialog (available only for devices with an 

integrated light control hardware module) 

 

 

 

FIGURE 9: SMARTVIS3D LIGHT CONTROL DIALOG 

 

No. Description 

1 Turns light on / off. Takes effect immediately. 

 

2 Light intensity control elements. Using either the scrollbar, the spin-control or by directly 

entering the desired intensity value in the input field the light intensity can be adjusted. 

Takes effect immediately. 

 

3 Store the intensity value and the power status of the led for further usage, e.g. to 

specify the light settings of a new measurement procedure in “Measuring procedures” 

dialog. 

 

4 Discard new settings and restore previous values. 

 

 

 

 

 

 

1 

2 

3 4 
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2.3.5. Stitching process 

 

Stitching is a process which makes it possible to measure more than one area and combine 

the obtained surface profiles to a single large profile. In Figure 10 an example of a stitching 

process is shown. In this example the results of four single measurements are stitched to a 

single surface profile. 

 

 

FIGURE 10: STITCHING OF FOUR SINGLE MEASUREMENTS TO A SINGLE LARGE SURFACE 

PROFILE 

 

To assure correct stitching of surface profiles some overlap of measured areas is required as 

shown in Figure 11. 

 

FIGURE 11: FOR CORRECT STITCHING OF TWO INDIVIDUAL MEASUREMENT AREAS REQUIRED 

AREA OVERLAP 
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2.3.5.1. Auto-stitching process (available only for devices with 

motorized positioning axes) 

 

If you want to obtain the surface profile of a large object which is not feasible using a single 

measurement than you can use the auto-stitching functionality of the smartVIS3D® software 

for this task. The auto-stitching operation mode is accessible through the “Stitching” menu 

entry of the “Options” menu in the main window of the smartVIS3D® software. Clicking on 

the “Stitching” menu entry will open the “Stitching-Measurement” dialog shown in Figure 12.  

 

Note: This menu entry is only available for devices equipped with motorized positioning axes 

in X and / or Y direction. Prior to calling the “Stitching-Measurement” dialog a proper report 

template file for handling stitching results of the smartVIS3D measurement software must be 

selected using the “Choose report template” menu entry in the “File” menu, see section 2.2. 

 

After calling the “Stitching-Measurement” dialog the size of the complete measurement area 

and the overlap of tiles must be specified using the corresponding input fields of the tab 

“prescan” in the option and control field (3). After these values are entered into the input 

fields the software automatically computes the required grid tile size in X and Y direction in 

such a way that the complete measurement area will be scanned. The computed grid will be 

shown in fields (1) and (2) of the auto-stitching dialog. Field (1) is the stitching grid used for 

during the “Prescan” procedure captured camera images. Initially the grid tiles of the field (1) 

have a black background color. Field (2) is used to show the progress status of the stitching 

procedure. Initially the grid tiles of the field (2) have a grey background color.  

After the stitching grid is computed by the software you can adjust it using the controls of the 

second tab (“manual”) in the option and control field (3). The content of the “manual” tab is 

shown in Figure 13. Using the “+” / “-“ control buttons for specific directions in the “multiplier” 

field specified number many rows respectively columns can be added or removed to and 

from the stitching grid. 

 

 



SMARTVIS3D – SOFTWARE USER GUIDE  
 

Seite 27 von 58                                                                                                                          23.01.2016 
 

 

 

 

 

FIGURE 12: SMARTVIS3D “STITCHING-MEASUREMENT” DIALOG 

 

 

After the grid satisfies the requirements of your measurement task press on the “Start 

Prescan” button of the “prescan” tab in the option field (3). By calling the “Prescan” 

procedure the motorized positioning stage will automatically assume measurement positions 

corresponding to the grid tiles at each of which the camera will capture a single frame of 

specimen’s surface. These frames will be shown in the grid field (1) of the “Stitching-

Measurement” dialog. Additionally the grid tiles of grid field (2) will be assigned a chartreuse 

background color. In Figure 14 an example of a 3x3 camera frames grid with captured 

camera frames and of a 3x3 progress status grid are shown. 

 

1 

2 

8 7 6 5 4 

3 
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FIGURE 13: THE "MANUAL" TAB OF THE "STITCHING-MEASUREMENT" DIALOG 

Using the frames shown in the grid field (1) you have to check if tiles are properly aligned to 

each other. Structures on specimen’s surface which stretch across multiple tiles may simplify 

this task as in many cases it can be easily seen whether segments of a single structure 

located in adjacent tiles are misaligned or not. If tiles are not properly aligned a calibration 

procedure for the measurement device is required. For details on calibration procedure see 

section 3.7. 

 

In case that the tiles are properly aligned and the size of the grid satisfies the requirements of 

your measurement task you can proceed with the actual stitching measurement. Change to 

the tab “measure” in the option field (3), shown in Figure 15, and click on the “Start” button to 

perform the measurement procedure. Using the information of the grid the software takes 

control over the motorized stage and the camera and executes the complete scan and data 

analysis procedure on each grid tile.  

 

9 

10 

13 

12 

11 
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FIGURE 14: SMARTVIS3D “STITCHING-MEASUREMENT” DIALOG AFTER THE PRESCAN 

PROCEDURE 

When the stitching measurement process is running, to show the progress of the stitching 

procedure in the camera grid field (1) the currently scanned grid tile is highlighted using a red 

border. Because in the initial state the center tile is assigned the red border, to avoid 

confusion during the measurement it will be assigned a purple border. Each processed tile 

will be additionally marked with a green background color in the progress status grid (2). In 

Figure 16 an example of the updated grid tiles is shown. 

 

 

FIGURE 15: THE "MEASURE" TAB OF THE "STITCHING-MEASUREMENT" DIALOG 

14 

16 17 
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After all tiles are processed press the “Ok” button. In the measurement results directory you 

will find grid time number many result files which you can view in the MountainsMap® 

analysis software. Although the smartVIS3D “Stitching-Measurement” is called stitching 

process the smartVIS3D software does no actual stitching of multiple result files to a single 

result file, but provides only a simpler way to scan multiple overlapping areas which can be 

stitched by additional software. MountainsMap® is capable of stitching the obtained result 

files. Refer to the manual of the MountainsMap® analysis software for more details. 

 

 

FIGURE 16: DISPLAY OF THE STATUS PROGRESS DURING THE STITCHING-MEASUREMENT 

PROCEDURE 

The following table contains a short description of control elements for the “Stitching-

Measurement” dialog: 

No. Short description 

1 Stitching grid used for captured camera frames. At startup each grid tile has a black 

background color. After execution of the “Prescan” procedure each grid tile contains a 

single camera frame of specimen’s surface captured at to the specific grid tile 

corresponding measurement position. 
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2 Stitching grid used to display the progress of currently running stitching process. Each 

already processed grid will be marked with a green background color. 

 

3 Options and procedure control field with three groups of controls. 

1. “Prescan”: Contains information about the size of the complete measurement 

area and the overlap size of grid tiles. Furthermore using “Take actual stage 

position as center” option the center of the grid can be specified. 

2. “Manual”: Contains control elements which are used to add new rows and 

columns to and remove rows and columns from the stitching grid. 

3. “Measure”: Contains control elements which are used to start and to cancel 

the stitching measurement procedure. 

  

4 This button is available under the tab “Prescan” of the option field (3) and it is enabled 

if a “Prescan” procedure is currently running. By pressing this button a currently 

running “Prescan” procedure can be canceled. 

 

5 This button is available under the tab “Prescan” of the option field (3) and it is enabled 

if no “Prescan” procedures are running. By pressing this button the “Prescan” 

procedure will be called and executed. 

 

6 Exit the “Stitching-Measurement” procedure. 

 

7 If the grid size is larger than three tiles in a single direction, these controls will be 

enabled otherwise they are disabled. Pressing on the “-“-zoom button you can zoom 

out and see more than 3x3 tiles. Pressing on the “+”-zoom button you can zoom in up 

to 3x3 tiles. 

 

8 Information about the view and the tile size. In case the mouse cursor is hovering on 

top of a tile the index of this tile will be shown here too. 

 

9 Add / Remove a tile column on the left side of the grid. 

 

10 Add / Remove a tile column on top of the grid. 
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11 Specifies the number of columns respectively rows which are inserted or removed on 

a single click on buttons 9, 10, 12 and 13. 

 

12 Add / Remove a tile column on the right side of the grid. 

 

13 Add / Remove a tile column on bottom of the grid. 

 

14 Lock the z-range movement for the selected tile. To select a tile press with the left 

mouse button on the desired tile. 

 

15 Start the stitching measurement procedure. 

 

16 Cancel the running measurement procedure. 

 

 

2.3.5.2. Manual stitching process 

 

 

FIGURE 17: MANUAL STITCHING OVERLAP AREAS 

1 2 
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In case your device has no motorized but a manual positioning stage you can use the 

manual stitching guide lines to simplify the measurement process for large objects. To make 

the guide lines visible in the “View menu” under the menu entry “Auxiliary lines / grids” the 

menu entry “Manual stitching overlap areas” must be enabled, see section 2.4. Additionally 

you have select “Manual stitching” menu option in the “Options” menu. The guide lines 

serves only as orientation guides as they show the overlap areas around the current grid tile 

area which is in the center of the live view. After enabling the overlap areas you have to 

manually start measurement procedure at each new grid tile and you have to adjust the 

position of the stage also manually in such a way that the overlap condition specified by 

MountainsMap® (approximately 20% of the tile area) and shown in Figure 11 is satisfied. 

E.g. after executing a measurement procedure on the tile shown in Figure 17 the grid tile on 

the left of this tile has to be scanned. For that the positioning stage must be moved to the 

right until the overlap area (1) on the left of the previous tile is on the right (2) of the new grid 

tile. After scanning as many as necessary tiles click on “Finish manual stitching” menu entry 

in the “Options” menu. Like in the auto-stitching mode in the measurement results directory 

you will find grid time number many result files which you can view in the MountainsMap® 

analysis software. 

 

2.4. View Menu 

Note: The view menu does not contain any items to call up dialogs. Instead various settings 

concerning the main dialog can be changed by checking or unchecking the view menu items. 

 

 

 

 

FIGURE 18: SMARTVIS3D VIEW MENU 

No. Description 

1 Show or hide the status bar in the main dialog. 

 

1 

2 

3 

4 

5 
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2 Show or hide the measurement settings in the main dialog. 

 

3 Because the camera resolution is larger than the size of the live view image only a 

partition of the camera frame is shown in the live view. To see the whole image enable 

this option. 

 

4 Show or hide guide lines. 

 

5 Show or hide calibration target positions. 

 

 

2.5. Help Menu 

 

 

FIGURE 19: SMARTVIS3D HELP MENU 

No. Description 

1 Opens the “Software protection” dialog which shows information regarding available 

software modules and licenses, as shown in the following figure: 

 

 

1 

2 
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2 Opens the “About smartVIS3D” dialog which shows version information of the 

smartVIS3D software, as shown in the following figure: 
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3. Measurement procedure 

3.1. Requirements 

3.1.1. Specimen 

 Used specimen must be clean (free of grease and dust) 

 Used specimen must be dry 

 Specimen’s surface should be as smooth as possible in order to achieve the highest 

possible measurement accuracy 

 Height discrepancy of points on specimen’s surface should not exceed the maximum 

measurement range of 400 µm to assure that for each surface point the necessary 

data required for computation of its height value is measured 

 The overall height of the specimen should not exceed 50 mm, which is the height limit 

of smartWLI measurement devices resulting from the fixed stand and drives used in 

these devices 

 In case that the measurement system is equipped with a tilting stage, do not use 

specimens with a total mass larger than 1 kg in order to avoid any mechanical 

damage to the measurement system and / or the specimen 

 

3.1.2. Environment 

 A low-vibration or an environment free of vibration is recommended for optimal 

measurement results 

 The environment of the measurement system should be dry 

 The environment of the measurement system should be dust-free or provides a low 

dust level 

 The environment of the measurement system should feature uniform and stable 

ambient conditions (ΔT < 1.0 K/h) and also a low and constant humidity 

 

Note: For more information on the optimal environment characteristics please refer to the 

hardware manual of your purchased measurement device.  
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3.2. Prior to a measurement 

 Please check whether the measurement task requires protective clothing (gloves, 

safety helmet, lab coat, protective shoes etc.) 

 If the measurement system had been just transported to the current site, set it up as 

necessary in accordance with the hardware manual purchased with the device 

 After setup perform a visual check for any damages. Damaged components must be 

repaired or replaced before a measurement procedure is conducted 

 In case that the measurement device is equipped with a tilting stage, please check 

the distance of the objective to the tilting stage and correct if necessary to avoid any 

damage to the measurement system and to provide sufficient distance to specimen’s 

surface. If the distance is adequate the specimen can be placed on the tilting stage 

 Place the specimen carefully on the tilting stage and position it as appropriate for your 

measurement task 

3.3. Measurement 

The measurement system has been calibrated by the manufacturer and is ready to use. After 

the system has been switched on, the current camera image (live image) is shown in the 

main window of the smartVIS3D measurement software. To obtain the height profile of a 

specimen’s surface following steps must be conducted: 

 

1. If not already done so, place the specimen on the tilting stage, if available, or on the 

positioning table of your measurement device 

2. Perform a coarse adjustment of the illumination intensity using steps described in 

section 3.4 

3. Configure the measurement options 

4. Level the specimen as necessary 

5. Focus the image and find interference fringes using the z-drive hand wheel of your 

measurement device. Please refer to the hardware manual of your device to find the 

z-drive hand wheel. 

6. Perform a fine adjustment of the illumination intensity using steps described in 

section 3.4 
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7. Set the upper and the lower limits for the scan range. Detailed description of the 

required steps in VSI mode can be find in section 3.8 and for the PSI mode in 

section 3.9 

8. Start the measurement procedure 

3.4. Adjusting the illumination 

If too much light is illuminated from the LED than the reflected and by the camera sensor 

captured amount of light may be as large that the effect of overexposure arises. In such a 

case yellow pixels appear in the grayscale video image shown in the live view window, see 

Figure 20.  

 

 

 

FIGURE 20: OVEREXPOSURE IN CASE OF INCORRECT ILLUMINATION 

 

This effect can be especially seen when interference fringes are visible in the live view 

image. If yellow pixels appear in the live view please reduce the illumination intensity using 

the control dial on the LED illumination control until the yellow pixels disappear. However, 

sufficient brightness must remain such that measurable interference fringes may arise and 

thus for computation of the height profile required data can be assessed during the 

measurement procedure. 

 

3.5. Configuration of measurement options 
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Before beginning measurements on new specimen’s surface, consideration should be given 

to the necessary settings in the “Measuring Options” dialog, see section 2.3.1ff. 

 

 

 

3.6. Leveling the system (applies only for measurement 

devices with a tilting stage) 

A well-leveled measurement system significantly improves the measurement accuracy. 

Therefore it is important to perform the leveling procedure after each disassembly and setup. 

Following steps are required to level a measurement system equipped with a tilting stage: 

 

1. Place a suitable specimen or a plane mirror on the tilting stage of your measurement 

device. Ensure that the specimen / mirror is placed firmly on the stage 

2. Using the z-drive hand wheel of your measurement device search for interference 

fringes in the live view 

3. If interference fringes have been found but these are too thin for useful 

measurements, in this case the fringes fill only a small fraction of the live view image 

as shown in Figure 21, then a leveling procedure is required 
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FIGURE 21: MEASUREMENT SYSTEM IS NOT LEVELED, THUS OBTAINED INTERFERENCE 

FRINGES ARE TOO THIN AND APPEAR ONLY IN A SMALL REGION OF THE LIVE 

VIEW IMAGE 

4. The smartVIS3D software provides specific guide lines which can be used to simplify 

the leveling procedure. You can find the guide line options using “Auxiliary lines / grid” 

menu entry of the “View” menu in the main dialog. If you have a tilting stage with 45° 

inclination adjustment use the “Auxiliary grid 45°” option, otherwise the “Auxiliary grid 

90°” option. In following it will be assumed that the measurement device is equipped 

with a 45° inclination tilting stage. In Figure 22 you can see the enabled 45° guide 

lines 
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FIGURE 22: ENABLED 45° AUXILIARY GRID LINES 

5. Try to align the interference fringes with the grid lines using the tilting screws. Turning 

a screw clockwise will lift the corresponding table corner. Turning a screw 

anticlockwise will lower the corresponding table corner. In case of incorrect leveled 

tilting stages adjusting the height level of a tilting screw will change the orientation of 

the visible interference fringes. For the orientation of the interference fringes as 

shown in Figure 22 turning the left screw clockwise will rotate the interference fringes 

anticlockwise. In Figure 23 for correct leveling required alignment of interference 

fringes with the grid lines achieved by turning the left screw clockwise is shown 
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FIGURE 23: WITH THE GRID LINES ALIGNED INTERFERENCE FRINGES 

 

6. After the interference fringes are aligned turn the second screw, in this example the 

right screw, to tilt the stage perpendicularly to the visible interference fringe pattern. In 

doing so the interference fringes will expand as shown in Figure 24a and Figure 24b 

 

 

(a) 

 

(b) 

FIGURE 24: EXPANSION OF INTERFERENCE FRINGES 
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7. As can be seen in Figure 24b if the tilting stage is not yet properly aligned the 45° 

orientation of the interference fringes will drift. In this case readjust the alignment of 

the interference fringes with the guide lines using the first tilting screw, in this 

example the left screw. In Figure 25 the accurately aligned interference fringe pattern 

is shown 

 

 

 

FIGURE 25: READJUSTED ALIGNMENT OF THE INTERFERENCE FRINGES WITH 

THE SHOWN GUIDE LINES 

8. After the interference fringes are properly aligned turn the second screw again to tilt 

the stage perpendicularly to the interference pattern. Proceed with the leveling 

procedure until the interference fringes expand evenly over the entire area visible in 

the live view image as shown in Figure 26 

 

9. Due to adjustments of the level of the tilting stage the image focus may be loosed and 

thus the interference fringes may disappear. In this case please readjust the z-

position of the objective using the z-drive hand wheel of the measurement device until 

the interference fringes appear again in the live view window 
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FIGURE 26: INTERFERENCE PATTERN VISIBLE IN CASE OF A PROPERLY 

ALIGNED TILTING STAGE 

 

  

 

 

3.7. System calibration 

The measurement system is calibrated by the manufacturer before delivery. When used 

correctly no recalibration is required. However, recalibration of the measurement device is 

required each time the objective is replaced. Following steps are required to calibrate the 

measurement system: 

 

1. If not already done so, switch the measurement system on 

2. Start the measurement software smartVIS3D 

3. Open the “File” menu and click on “Start calibration procedure” (1), see Figure 27, to 

start the calibration 
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FIGURE 27: "START CALIBRATION PROCEDURE" ENTRY IN "FILE MENU" 

4. After pressing on “Start calibration procedure” menu entry a series of instruction 

dialogs will be opened after another, each of which you must read carefully 

5. In the first instruction dialog, see Figure 28, the selected objective and the 

magnification factor are shown. Verify that these correspond to the settings in the 

“Measuring Option” menu. If not cancel the calibration procedure by clicking on the 

“Cancel” button. If the settings are correct confirm that by clicking on the “OK” button 

 

 

 

FIGURE 28: FIRST INSTRUCTION DIALOG OF THE CALIBRATION PROCEDURE 

6. The second instruction dialog provides information about a calibration target 

corresponding to the selected magnification factor, see Figure 29. Make sure to use 

the correct calibration target, because only if the proper target is used a correct 

calibration of your measurement device is feasible 

a. The coated side of the calibration target must be at the bottom 

b. For measurement devices with a tilting stage correct leveling of the stage 

must be assured. Therefore cancel the calibration procedure after placing the 

calibration target on the tilting stage and proceed with the leveling, as 

described in section 3.6. After the measurement device is well-leveled repeat 

calibration steps 1 – 5 and continue the calibration procedure with step 7 

 

1 
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FIGURE 29:  SECOND INSTRUCTION DIALOG OF THE CALIBRATION PROCEDURE 

7. Push the “OK” button of the second instruction dialog to proceed to the next dialog 

8. In the third instruction dialog, see Figure 30, you will be asked to position the 

calibration target and to adjust the height of the measurement stage using the z-drive 

hand wheel such that: 

a. The calibration target is shown area-wide in the whole live view image 

b. It lies in focus of the objective and in the live view a contrast-rich image is 

shown 

Perform illumination adjustments if necessary, see section 3.4 for details. In Figure 31 

an example of desired results is shown. Push “OK” to proceed to the next dialog 

 

 

 

FIGURE 30: THIRD INSTRUCTION DIALOG OF THE CALIBRATION PROCEDURE 

9. The actual calibration is done using a series of measurements at three different 

positions, meaning that after a measurement series is completed the position of the 

calibration target must be adjusted using the x-y hand wheels of the microscope 

stage. At each new position conditions 8a and 8b must be satisfied 
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FIGURE 31:  A CONTRAST-RICH, OVER THE WHOLE LIVE VIEW FIELD EXTENDED IMAGE OF THE 

CALIBRATION TARGET 

a. In the fourth instruction dialog, see Figure 32, you will be asked if you want to 

start the calibration measurement series at the first calibration position. By 

clicking the “YES” button the calibration at the current position shown in the 

live view of the main dialog will be executed 

 

 

 

FIGURE 32:   FOURTH INSTRUCTION DIALOG OF THE CALIBRATION PROCEDURE 
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b. If the calibration procedure was successful red crosses will appear in the 

center of the circles as shown in the following figure: 

 

 

 

After the series of measurements at the first position is completed the dialog 

shown in Figure 33 will be automatically opened. In this dialog you will be 

notified that the first measurement series is completed. Additionally you will be 

asked to change target’s position using the x-y hand wheels of the 

microscopic stage to proceed with the second series of measurements. Make 

sure that conditions 8a and 8b are satisfied 

 

 

 

FIGURE 33: FIFTH INSTRUCTION DIALOG OF THE CALIBRATION PROCEDURE 
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c. By clicking the “YES” button the second series of calibration measurements 

will be performed 

d. Again if the calibration procedure was successful red crosses will appear in 

the center of the circles. After the second series of measurements is 

completed the dialog shown in Figure 34 will be automatically opened. In this 

dialog you will be notified that the second measurement series is completed. 

Additionally you will be asked again to change target’s position using the x-y 

hand wheels of the microscopic stage to proceed with the third and last series 

of calibration measurements. Make sure again that conditions 8a and 8b are 

satisfied 

 

 

 

FIGURE 34: SIXTH INSTRUCTION DIALOG OF THE CALIBRATION PROCEDURE 

e. After the third and last series of calibration measurements are completed the 

dialog shown in Figure 35 will be automatically opened. In this dialog you will 

be notified that all required calibration measurements have been completed 

and that a new length scale corresponding to the selected objective and 

software settings has been determined, e.g. in Figure 35 the length scale 

value is approximately 0.00065 mm. If you want to apply the new length scale 

setting click the “YES” button, if not than the “NOT” button. 
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FIGURE 35: SEVENTH INSTRUCTION DIALOG OF THE CALIBRATION PROCEDURE 

f. After pressing the “YES” button the new length scale will be applied to 

software settings and the last instruction dialog, see Figure 36, will be shown 

in which you will be notified that the calibration process is completed. Press 

the “OK” button to close this dialog. After that the calibration procedure is 

completed 

 

 

 

FIGURE 36: LAST INSTRUCTION DIALOG OF THE CALIBRATION PROCEDURE 
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3.8. Measurements in VSI mode 

Before a measurement procedure is executed make sure that the following prerequisites are 

fulfilled: 

 Read and follow the information on the correct usage of the measurement device 

described in the hardware manual of your measurement device 

 Turn on the measurement system 

 Read and comply with the instructions from section 3.2 

 Place the specimen on the microscopic stage underneath the installed objective 

 Set the illumination coarsely, see section 3.4 for information on how to adjust the 

illumination settings 

 Select the VSI measurement mode in the “Measuring Options Menu”, see section 

2.3.1 and the other settings necessary for your measurement task 

 Leveling of the tilting stage has been performed as necessary (applies only for 

measurement devices equipped with a tilting stage) 

Note: If the magnitude of the Ra value is unknown it is recommended to choose the “Rough” 

setting initially. After the measurement procedure is completed the Ra value can be 

determined using the analysis software MountainsMap®. If this value is below 200 nm then 

subsequent measurements can be repeated using the setting “Smooth” to achieve higher 

measurement accuracy. 

 

 

Measurement Procedure: 

1. Set the z-position of the objective to the middle of the movement range of the piezo 

adjuster using the scrollbar (8) or the arrow buttons and above (4) and below (12) the 

scrollbar area. Default movement range of the piezo adjuster is 0.4 mm thus the 

value shown in the display field “Currently” (2) should be approximately 0.2 after 

adjusting the position of the objective as required. Alternatively the desired value can 

be entered in the input field (3) on the right of the “Go” button (1). By pressing the 

“Go” button (1) after the value was entered in the input field (3) the position of the 

scrollbar (8) as well as the value in the display field “Currently” (2) will be updated to 

the desired position and value respectively 

2. Adjusting the z-position of the objective search for interference fringes in the live view 

image (15) until they appear in the center of the image 
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Note: The complete movement range of the piezo adjuster is only available in case no 

upper and lower scan range limits were set by the user 

 

3. Move up the position of the objective using the scrollbar (8) or the arrow buttons (4) 

and (12) until the interference fringes are no longer visible in the live view image (15). 

Click on the “Set” button (7) for the upper scan range limit to set the upper bound in 

the measurement software to this value. In the display field for the upper bound (5) 

the shown value will be updated to the current z-position of the objective which is 

displayed in the “Currently” field (2). Furthermore to show that a user defined upper 

bound is set the background of the display field (5) will be set to blue. If you want to 

reset the upper scan range limit to its default value press on the “Reset” button (6). 

By doing so the value for the upper bound will be set to the maximum scan range 

value and the background color of the field (5) will be changed to black 

4. After setting the upper bound using the scrollbar (8) or the arrow buttons (4) and (12) 

move the position of the objective down until the interference fringes appear and 
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disappear again. Click on the “Set” button (11) for the lower bound of the scan range 

to update the lower scan limit in the software. Like for the upper bound by pushing the 

“Set” button (11) the value in the display field (9) for the lower bound will be updated 

to the current z-position shown in display field (2) and the background color of the 

field (9) will be changed to blue. To reset the lower bound to the default value press 

the “Reset” button (10). By doing so the value for the lower bound will be set to the 

minimum scan range value and the background color of the field (9) will be changed 

to black 

5. Check if the illumination settings have been set to a suitable magnitude, such that no 

yellow pixels which identify overexposed areas are present in the live view image. It 

isn’t possible to take any valid measurement from overexposed areas, which is why 

overexposure should be avoided. Change the illumination settings if necessary. After 

proper illumination settings have been selected you can proceed with the 

measurement by clicking on the “Start Measurement” button (13) 

6. After pressing the “Start Measurement” button the measurement procedure will take 

place. The progress bar (14) will show the current status of the running 

measurement. During the measurement the live view shows captured images which 

are used in the computation process. Furthermore, all controls for manipulations of 

the z-position of the piezo adjuster will be disabled, such that the user cannot 

interfere with the measurement software  

7. After the measurement is completed the measurement results will be sent 

automatically to the analysis software MountainsMap® and displayed graphically. 

During the measurement procedure disabled z-position control elements will be 

enabled again. If wished the measurement results can be saved in a desired format. 

Supported formats are listed in section 2.2 

 

 

3.9. Measurements in PSI mode 

Before a measurement procedure is executed make sure that the following prerequisites are 

fulfilled: 

 Read and follow the information on the correct usage of the measurement device 

described in the hardware manual of your measurement device 

 Turn on the measurement system 

 Read and comply with the instructions from section 3.2 

 Place the specimen with a smooth surface on the microscopic stage underneath the 

installed objective 
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 Set the illumination coarsely, see section 3.4 for information on how to adjust the 

illumination settings 

 Select the VSI measurement mode in the “Measuring Options Menu”, see section 

2.3.1 and the other settings necessary for your measurement task 

 Leveling of the tilting stage has been performed as necessary (applies only for 

measurement devices equipped with a tilting stage) 

Note: If the magnitude of the Ra value is unknown it is recommended to choose the “Rough” 

setting initially. After the measurement procedure is completed the Ra value can be 

determined using the analysis software MountainsMap®. If this value is below 200 nm then 

subsequent measurements can be repeated using the setting “Smooth” to achieve higher 

measurement accuracy. 

 

Measurement Procedure: 

1. Set the z-position of the objective to the middle of the movement range of the piezo 

adjuster using the scrollbar (8) or the arrow buttons and above (4) and below (12) the 

scrollbar area. Default movement range of the piezo adjuster is 0.4 mm thus the 

value shown in the display field “Currently” (2) should be approximately 0.2 after 

adjusting the position of the objective as required. Alternatively the desired value can 

be entered in the input field (3) on the right of the “Go” button (1). By pressing the 

“Go” button (1) after the value was entered in the input field (3) the position of the 

scrollbar (8) as well as the value in the display field “Currently” (2) will be updated to 

the desired position and value respectively 

2. Adjusting the z-position of the objective search for interference fringes in the live view 

image (15) until they appear in the center of the image 

3. Adjust the angle of the tilting stage in such a way that the number of visible 

interference fringes in the live view image is as small as possible. However the visible 

fringes should span the entire view area 

4. Move the position of the objective slightly up using the scrollbar (8) or the arrow 

button up (4) and click on the “Set” button (7) for the upper scan range limit. In the 

display field for the upper bound (5) the shown value will be updated to the current z-

position of the objective which is displayed in the “Currently” field (2). Furthermore to 

show that a user defined upper bound is set the background of the display field (5) 

will be set to blue. If you want to reset the upper scan range limit to its default value 

press on the “Reset” button (6). By doing so the value for the upper bound will be set 

to the maximum scan range value and the background color of the field (5) will be 

changed to black 
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Note:  The complete movement range of the piezo adjuster is only available in case 

no upper and lower scan range limits were set by the user 

 

5. Move the position of the objective slightly down covering at least the double distance 

as before. Click on the “Set” button (11) for the lower bound of the scan range to 

update the lower scan limit in the software. Like for the upper bound by pushing the 

“Set” button (11) the value in the display field (9) for the lower bound will be updated 

to the current z-position shown in display field (2) and the background color of the 

field (9) will be changed to blue. To reset the lower bound to the default value press 

the “Reset” button (10). By doing so the value for the lower bound will be set to the 

minimum scan range value and the background color of the field (9) will be changed 

to black 

6. Check if the illumination settings have been set to a suitable magnitude, such that no 

yellow pixels which identify overexposed areas are present in the live view image. It 

isn’t possible to take any valid measurement from overexposed areas, which is why 

overexposure should be avoided. Change the illumination settings if necessary 
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7. Move the scrollbar up in between of the upper and lower scan range limit. By pushing 

the “Start Measurement” button (13) the measurement procedure will begin. The 

progress bar (14) will show the current status of the running measurement. During the 

measurement the live view shows captured images which are used in the 

computation process. Furthermore, all controls for manipulations of the z-position of 

the piezo adjuster will be disabled, such that the user cannot interfere with the 

measurement software 

8. After the measurement is completed the measurement results will be sent 

automatically to the analysis software MountainsMap® and displayed graphically. 

During the measurement procedure disabled z-position control elements will be 

enabled again. If wished the measurement results can be saved in a desired format. 

Supported formats are listed in section 2.2 
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4. Troubleshooting 

Error Message / Disruption Possible cause Possible Resolution 

Application is already running The smartVIS3D measure-

ment software is already 

running or is currently 

active 

 

Note: Only a single instance 

of the smartVIS3D software 

can be running at once 

Quit the measurement soft-

ware and wait a moment. Start 

the software again. If the error 

appear again but no 

smartVIS3D GUI is shown, use 

the Windows Task Manager to 

terminate the running 

smartVIS3D process 

Camera error: No camera found  The controller box is not 

switched on 

 The Ethernet cable is 

not inserted correctly or 

is defective 

 Instrument cable could 

be defective or is not 

inserted correctly 

 Turn on the controller box 

 Check the Ethernet cable 

 Check the instrument cable 

Note: Wait a moment (≥ 10 s) 

after switching on the 

controller box, as it 

requires some initiali-

zation time 

Initialization: MIPOS-Error 

(getstat): 2 

 Incorrect COM port is 

used 

 The USB cable is not 

inserted correctly 

 Check the serial cable 

connection and whether it 

is connected to the correct 

USB port 

Initialization: MIPOS-Error 

(open): 4 

 Configuration error, 

selected COM port does 

not exist 

 Change the configuration 

file 

 Contact the GBS mbH 

service team 

 No image is visible 

 A black or a blue image is 

shown (possible with some 

noise) 

 Illumination is not turned 

on 

 Control device is not 

connected to the power 

supply 

 Switch on the illumination 

using the controls in the 

software 

 Check whether the USB 

cable is connected 
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